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Bảng điều khiển files 
 

 
 
BÀI 6 NGÀY 10.8.2009 SOẠN THEO KS NGUYỄN TRƯỜNG SINH. 

 
Bài này nêu lý thuyết hướng dẫn sử dụng các Công cụ của Dreamweaver , bạn cần nắm 
vững để thực hành trong các bài sau . Để làm việc với các Tập Tin và Thư Mục tạo nên 

Website ( Tất cả nằm trong Folder Website mà bạn đã đặt tên lúc ban đầu ) , bạn cần 
sử dụng Bảng Điều Khiển ( BĐK) Files . BĐK Files cho phép bổ sung và xóa bỏ các Files 

và Folders , xem và thay đổi Site Cục Bộ hoặc Site Ở Xa , cũng như thực hiện thao tác 
duy trì Site . 
BĐK Files ở bên Phải Cửa Sổ được gắn dính với những BĐK khác . Theo mặc định nó ở 

dưới cùng của Nhóm BĐK Files . Nó gồm một vài Menu bật lên , một Thanh Công Cụ  và 
Vùng Liên Kết chứa các tập Tin .  
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I.DI CHUYỂN ĐẾN CÁC Ổ DỈA VÀ SITE 
 
Menu  Browser bật lên trong phần đầu của BĐK Files cho phép bạn chọn trong Ổ cứng 
và dễ dàng chuyển đổi giữa các Sites đã định nghĩa . Các Sites đã định nghĩa xuất hiện 

trong menu dưới dạng Thư Mục ( Folder) . 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

1. CÁCH THỨC DUYỆT TÌM TRÊN Ổ DỈA CỨNG : 
 

 Trong BĐK Files , chọn Ổ Dỉa mong muốn (Ổ C) từ Menu Browser bật lên . 

 Nội dung Ổ C xuất hiện trong Vùng Chứa Các Tập Tin . 

 Di chuyển đến các Files và Folders cần thiết . 
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2. CHUYỂN ĐỔI CHẾ ĐỘ HIỂN THỊ CỤC BỘ VÀ Ở XA : 
 

Trong BĐK Files , ở trên cùng có vài Ô kèm theo Nút Xổ Xuống , khi bạn nhấp lên 
sẽ bật ra Menu Con để bạn chọn . Ô đầu tiên là Menu Browser khi nhấp xổ xuống 

sẽ bật ra Menu Con chứa danh sách các Ổ Dỉa trong Máy Tính của bạn . 
 

 Menu Browser , nhấp Xổ Xuống chọn Desktop> Chọn site090804 ( Đây là 
nơi lưu site090804 mà bạn đã tạo  sau khi đã Test Connect thành công với 

Site Ở xa ) . 
 

 
 

 Khi bạn nhấp lên site090804 trong Vùng Chứa các tập Tin , Menu Browser 
sẽ hiện ra Folder này trong Menu Site  > Nhấp xổ xuống Menu Hiển Thị 

Files ( Menu Files View ) , chọn Remote View ( Xem Ở Xa ) > Bật lên Bảng 
Background  File Activity – site090804 đang chạy kết nối với Host Free : 

www.byethost.com >  
 
 

 
 

 
 

 
 
 

 
 

http://www.byethost.com/
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 Sau khi hoàn tất kết nối thành công sẽ hiện ra danh sách các sites đã có 

trong Host Free này trong Vùng Chứa Các tập Tin . Chưa có site090804 vì 
bạn chưa Nhấp Nút Put Files để Upload lên Host Free . 

 
 

 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 Các bạn có thể kiểm tra kết quả của kết nối bằng cách xem nút nhấn 

Connect/Disconnect được tô sáng và các tập tin ở xa xuất hiện trong Vùng 
Chứa Tập Tin . 

 Menu Files View bật lên còn có 2 lựa chọn khác : Testing Server  ( Máy Chủ 

kiểm Tra ) và Map View ( Chế độ thể hiện theo sơ đồ ) . Sách này không đề 
cập đến máy Chủ Kiểm tra nhưng sẽ giải thích về chế độ thể hiện sơ đồ . 
 

3. LÀM MỚI CÁC CHẾ ĐỘ THỂ HIỆN : 
 

 Khi chuyển đổi sang chế dộ hiển thị Cục Bộ hoặc Ở Xa của 1 Site , 
Dreaweaver sẽ quét nội dung của Thư Mục trong Site Cục Bộ  hay Site Ở 

xa và hiển thị nội dung hiện tại .  
 Đôi khi chế độ thể hiện trong BĐK Files có thể trở nên lỗi thời . Ví dụ : Nếu 

bạn Upload lên hay xóa bỏ vài đề mục trong Site bằng 1 chương trình khác 
Những thay đổi đó sẽ không được thể hiện trong BĐK Files . 

 Tương tự như vậy , khi bạn di chuyển Files hay Folder vào Thư Mục Gốc 
Cục Bộ ( Có thay đổi trong Folder Website ) , bạn cần thông báo để 

Dreaweaver quét lại vá làm mới phần hiển thị Site Cục Bộ . 
o Chọn Site cần làm mới từ Menu Browser bật lên . 

o Chọn chế độ hiển thị ( Local View hay Remote View ) từ Menu Files 
View . 

o Nhấp Nút Refresh ( làm Mới ) trong Thanh Công Cụ của BĐK . 
o Dreamweaver sẽ quét lại Site được chọn và cập nhật Vùng Chứa Các 

Tập Tin . 
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II.LÀM VIỆC VỚI TẬP TIN VÀ THƯ MỤC 
 
 

BĐK Files rất hữu dụng để tổ chức tất cả các tập tin trên Site và tạo Tập tin và Thư 
Mục nới . Bạn nên thực hiện Tạo và Quản Lý tập tin trong BĐK Files do nó tiết kiệm 
thời gian hơn so phương thức khác trong Dreamweaver . 

Ví dụ : Bạn tạo 1 Site Mới bằng cách chọn File > New > Chọn kiểu Trang trong HT New 
Documents và chỉnh sửa Trang > Khi lưu HT bạn phải di chuyển đến đúng Thư Mục của 

Site Cục Bộ > Đặt tên cho Trang > Lưu nó .  
Ngược lại để tạo Trang Mới trong 1 Thư Mục cụ thể bằng cách sử dụng BĐK Files > 

Chọn Thư Mục muốn lưu Trang > Chọn lệnh New File . 
Lưu Ý : Trong Vùng Chứa các Tập Tin rất giống Windows Explorer nhưng đừng nghĩ là 
chúng tương tự nhau và nghĩ là có thể thực hiện việc quản lý Tập tin trên máy tính của 

mình . Dreamweaver được thiết kế để làm việc với các Trang và có thể thực hiện nhiều 
thao tác hữu dụng ( Cập nhật liên kết trên Trang để làm việc hiệu quả , ngay cả khi di 

chuyển Trang chứa liên kết đến 1 thư mục khác trên Site ) . 
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1. CÁCH THỨC TẠO TẬP TIN HOẶC THƯ MỤC MỚI : 
 

 Bạn thường tạo File hay Folder trong Site Cục Bộ do đó trong Menu Files 

View chọn Local View > Menu Browser bật lên chọn nơi lưu Site > Menu 
Files bật lên : 

 Chọn site090804 : Nếu tạo File hay Folder cho site này , bạn nhấp Phải lên 

Site này > Hiện ra Menu tắt xuất hiện cung cấp nhiều tùy chọn > Chọn 

New File hay New Folder > File hay Folder xuất hiện trong Vùng Chứa Các 
Tập Tin (VCCTT) > Nhập Tên cho nó . 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 Chọn 1 File hay 1 Folder  : Nếu tạo File hay Folder cho 1 File hay 1 Folder  , 
bạn nhấp Phải lên nó > Hiện ra Menu tắt xuất hiện cung cấp nhiều tùy 

chọn > Chọn New File hay New Folder > File hay Folder xuất hiện trong 
Vùng Chứa Các Tập Tin (VCCTT) > Nhập Tên cho nó . 

 
2. CÁCH THỨC DI CHUYỂN TẬP TIN HOẶC THƯ MỤC : 

 

 Chọn tất cả Files Hình Ảnh > Rê vào Folder images mới tạo > Hiện ra Bảng 

Update Files > Nhấp Update . 
 Dreamweaver sẽ cập nhật tất cả các liên kết trong Site bị ảnh hưởng bởi 

thao tác di chuyển . 
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3. CÁCH THỨC ĐỔI TÊN TẬP TIN HOẶC THƯ MỤC : 

 
 Nhấp Phải vào Tập Tin hoặc Thư Mục trong Vùng Chứa Tập Tin . 

 Từ Menu tắt , chọn Menu con Edit > Chọn 1 trong số các đề mục của Menu 

Edit . 
 Bạn có thể dùng lệnh Cắt – Sao Chép – Dán – Xóa Bỏ - Tạo bản sao – Đổi 

tên cho Tập Tin hay Thư Mục . ếu thao tác của Tập tin ảnh hưởng đến 
những tập tin khác , Dreamweaver sẽ hiển thị HT “Are you sure ? “ hoặc 

HT Update Files ( Cập nhật các Tập Tin ) . 
 Bạn hãy chú ý các phím Tắt được liệt kê trong tùy chọn menu Edit . Việc sử 

dụng Phím tắt sẽ tiết kiệm thời gian . 
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4. XUẤT VÀ NHẬP TẬP TIN : 
 

 Bạn có thể sao chép : Các tập Tin – Các Thư Mục – Hay toàn bộ Site  giữa 

Site Cục Bộ và Site Ở xa bằng BĐK Files . 
 Thuật ngữ :  

o Việc di chuyển 1 Đề  Mục từ Site Cục Bộ đến Site Ở Xa gọi là : Xuất 
Đề Mục . 

o Việc di chuyển 1 Đề  Mục từ Site Ở xa đến Site Cục Bộ  gọi là : Nhập 
Đề Mục . 

 Nếu thao tác xuất và nhập ghi đè lên 1 tập Tin  ( Khi đã có tên trùng lấp 

với tên Tập tin dán vào ) , Dreameaver sẽ cảnh báo . Nếu chọn 1 Folder , 

nó sẽ di chuyển tất cả Files trong đó . Vì vậy khi chọn 1 Folder Gốc Cục Bộ   
bạn có thể xuất toàn bộ Site đến Máy Chủ Ở xa chỉ một vài lần nhấp chuột 
Bạn có thể dùng đặc điểm Đồng Bộ Hóa Site của Dreamweaver thay vì 

xuất hoặc nhập từng đề mục . 
 

5. CÁCH THỨC XUẬT HOẶC NHẬP TẬP TIN HAY THƯ MỤC : 
 

 Trong BĐK Files , chọn chế độ thể hiện Local hay Remote từ Menu Files 

bật lên > Hiển thị các Files trong Vùng Chứa tập Tin . 

 Chọn Tập tin hay Thư Mục cần di chuyển . 
 Nhấp Nút Get File ( Nhập tập Tin ) hoặc Put File ( Xuất tập Tin ) trong 

Thanh Công cụ . 
 Nếu Tập tin được truyền vẫn đang mở  và chưa lưu những thay đổi , 

Dreamweaver sẽ hỏi bạn có muốn lưu tập tin trước khi di chuyển hay 

không . Nhấp Yes hoặc Yes To All ( Nếu có nhiều tập tin ) . 
 Dreamweaver cũng hiển thị 1 HT hỏi bạn có muốn truyền tập tin phụ 

thuộc hay không ? Ví dụ : Những tập tin phụ thuộc là các đồ họa trên 
Trang đang tải lên . Nếu tập tin phụ thuộc đã được tải lên nhấp No  ( Vì 

không cần phải tải lại các tập tin vẫn không thay đổi ) . Nếu muốn 
truyền tập tin phụ thuộc đã thay đồi , nhấp Yes . 
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6. CÁCH THỨC MỞ RỘNG BẢNG ĐIỀU KHIỂN FILES : 
 

Thông thường BĐK Files chỉ thể hiện Site Cục Bộ hoặc Site Ở Xa . Tuy nhiên nếu 
muốn so sánh các tập tin và Thư Mục trên cả 2 Sites  . Bạn mở rộng BĐK Files 

bằng cách nhấp Nút Expand/Colapse ( Mở rộng /Thu hẹp ).Để thu gọn BĐK Files 
bạn nhấp lại lần nửa . 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 

7. ĐỒNG BỘ SITE CỤC BỘ VÀ SITE Ở XA : 

 
Việc có 2 bản sao của 1 Website ( 1 trong Máy Cục Bộ và 1 trên Máy Chủ ) có thể 

phát sinh vấn đề : Bãn đã cập nhật một số Trang trong Site Cục Bộ nhưng sau đó 
không nhớ Tập tin nào đã thay đổi . Trong trường hợp này rất khó cho quyết 
định xem bản sao nào là bản sao mới nhất ( Cục Bộ hay Ở xa ? ) . Lệnh 

Synchronize sẽ so sánh 2 Site này , rồi truyền những tập tin mới nhất đến cho 
Site còn thiếu Tập Tin . 

Các bạn có thể thực hiện 1 trong 2 cách : 
 

HỘP THOẠI SYNCHRONIZE FILES : 
 

 Nhấp Phải vào BĐK Files > Menu Tắt xuất hiện > Chọn Synchronize Files > 

Chọn Site > Synchronize SiteWide ( Đồng bộ toàn Site ) > HT Synchronize 

Files xuất hiện : 
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o Từ Menu Synchronize bật lên , chọn : 
 Entire ”site090805” Site :  Toàn bộ Site . 

 Selected Local Files Only : Chỉ chọn Files trong Local Files . 
o Từ Menu Direction bật lên , chọn cách thức muốn sao chép những 

Tập tin mới nhất : 
 Put never files to remote : Xuất những tập tin mới nhất đến 

site ở xa . 

 Get newer files from remote : Nhập những tập tin mới nhất từ 
Site Ở xa ( Tìm những tập tin mới nhất trên máy Chủ và sao 

chép chúng về Thư mục của Site Cục Bộ ) . Tùy chọn này cũng 
sẽ sao chép toàn bộ những tập tin mới được tạo trên Máy Chủ 

Web ( Ví dụ gửi  các tập tin được đặt ở đó bởi đồng nghiệp ) 
đến Thư mục của Site Cục Bộ . 

 Get and Put newer files ( Nhập và xuất những tập tin mới 

nhất) : Đồng bộ các Tập tin theo cả 2 chiều . Những tập tin mới 
trên site Cục bộ sẽ được truyền đến Site Ở xa và ngược lại  

 Delete remote files not on local drive  : Xóa bỏ các tập tin ở xa 
không có trong ổ dỉa cục bộ .( Ví dụ chôn cái này ). 

 Nhấp Preview xem trước > Hiện ra Bảng Background Files 
Activity-site090805 đang đồng bộ 2 chiều . 
 

Dreamweaver sẽ kết nối đến site ở xa và so sánh những tập tin được chọn để 
đồng bộ hóa , rồi hiển thị HT Synchronize . Thao tác này cho phép xem trước 

những thay đổi sẽ xuất hiện trên Site . 
 
BẢNG SYNCHRONIZE : 

 
 Cột Action thông báo đề nghị thao tác đối với từng tập tin . 

 Nếu cần , bạn hãy chọn 1 hay nhiều tập tin và chọn 1 trong những nút 
nhấn thực thi ở dưới : 

o Get ( Nhập ) : Đánh dấu nhửng Tập tin được chọn để tải xuống từ 
site ở xa . 

o Put ( Xuất ) : Đánh dấu nhửng Tập tin được chọn gửi đến site ở xa . 

o Delete ( Xóa bỏ ) : Đánh dấu nhửng Tập tin được chọn để xóa bỏ. 
o Ignore ( Bỏ qua ) : Thông báo cho Dreaweaver bỏ qua những tập tin  

được chọn đối với thao tác đồng bộ hóa . 
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o Mash as Synchronize ( Đánh dấu như đã đồng bộ hóa )  : Thông báo 
Dreaweaver xem những tập tin được chọn như đã đồng bộ hóa  , nên 

sẽ không có thao tác nào diễn ra . 
o Compare ( So sánh ) : Mở các phiên bản tập tin Cục Bộ và Ở xa để có 

thể so sánh sự khác biệt của chúng > Ok .Dreaweaver sẽ thực thi 
thao tác Đồng Bộ Hóa . 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
8. DẤU CÁC TẬP TIN : 

 
Không phải tất cả Thư Mục trong Site Cục Bộ đều cần phải tải lên Site Ở xa . 

Dreamweaver cho phép dấu cá thư mục ( Folder ) : Nghĩa là chúng sẽ được loại 
trừ các thao tác đồng bộ hóa . Việc này giúp các bạn tiết kiệm được thời gian . Ví 
dụ : NHững Folder chứa Film dung llượng rất lớn đã có sẵn trong 2 Site mà 

không cần thay đổi nội dung của nó , Dreamweaver sẽ không quét nó khi đồng 
bộ hóa . Khi đã tải những tập tin lên hãy mở khóa cho Thư Mục chứa Film và 

thực hiện thao tác đồng bộ hóa . 
 

 Nhấp Phải lên 1 Folder chau71 các Files trong Vùng Chứa Tập Tin . 

 Menu Tắt xuất hiện > Chọn Cloaking > Chọn Cloak . Việc lam này khiến 

cho Folder này không bị ảnh hưởng gì trong lúc đồng bộ hóa. 
 Dreamweaver sẽ hiển thị Folder này với dấu gạch chéo cho biết nó đang bị 

dấu . 
 Bạn có thể dấu Folder nhưng không dấu được từng File riêng lẻ . Tuy nhiên 

bạn có thể khóa tất cả các tập tin có cùng một kiểu : 

o Menu Site > Manage Site > Tab Advanced > Chọn Site đang làm việc 
>  Chọn Cloaking > Kích hoạt 2 Hộp Kiểm  
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 Cách mở Folder bị dấu : Nhấp Phải vào Thư Mục bị dấu trong Vùng chứa 

Tập tin > Chọn Cloaking > Unclock hoặc Cloaking > Uncloak All ( Hiển 

thị tất cả ) . 
 

GIÁO TRÌNH UTBINH SOẠN : Đến ngày 10.8.2009 
 

 42 BÀI FRONTPAGE 2003 UTBINH SOẠN ĐỢT 3 : 
FRONTPAGE_2003_42LESSONS.rar (58.34 MB) : 

http://tinyurl.com/utbinh008  
 45 BÀI FRONTPAGE 2003 UTBINH SOẠN ĐỢT 1 VÀ 2 

(35.91MB): http://tinyurl.com/utbinh009 
 34 BÀI DREAMWEAVER 8 UTBINH SOẠN (21.17MB): 

http://tinyurl.com/utbinh142 
 52 Bài Thiết Kế Web HTML utbinh soạn (46.07MB)  : 

http://tinyurl.com/utbinh0010 
 15 Bài Expressions Web  utbinh soạn (36.92MB) : 

http://tinyurl.com/utbinh0012 
 39 Bài Power Point utbinh soạn ( 47.50 MB ) : 

http://tinyurl.com/43ogba 
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